
PLEASE THINK BEFORE YOU PRINT
SMART Sync 2009
System Administrator’s Guide



Product Registration

If you register your SMART product, we’ll notify you of new features and software 
upgrades.

Register online at www.smarttech.com/registration.

Keep the following information available in case you need to contact SMART 
Technical Support.

Product Key: ___________________________________________________

Date of Purchase: ___________________________________________________
Trademark Notice
The SMART logo and smarttech and are trademarks or registered trademarks of SMART Technologies ULC in the U.S. 
and/or other countries. Microsoft, Windows, Excel and Active Directory are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. All other third-party product and company names are 
mentioned for identification purposes only and may be trademarks of their respective owners.

Copyright Notice
©2008–2009 SMART Technologies ULC. All rights reserved. No part of this publication may be reproduced, transmitted, 
transcribed, stored in a retrieval system or translated into any language in any form by any means without the prior written 
consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not 
represent a commitment on the part of SMART.

Patents pending.

06/2009



 

Contents

1 Welcome ............................................................................................................... 1

About This Guide ............................................................................................ 1

About SMART Sync........................................................................................ 2

2 Installing SMART Sync ......................................................................................... 5

Before Installing SMART Sync ....................................................................... 5

Selecting a Tool .............................................................................................. 7

Locating the Installation Packages ................................................................. 8

3 Using the Command Line Interface....................................................................... 9

Completing SMART Sync Teacher Installation Tasks .................................... 9

Completing SMART Sync Student Installation Tasks................................... 12

Properties ..................................................................................................... 14

Parameters ................................................................................................... 18

Examples ...................................................................................................... 18

4 Using SMART Install Manager............................................................................ 21

Installing SMART Install Manager ................................................................ 21

Working with SMART Install Manager .......................................................... 22

Customizing the SMART Sync Teacher Installation Package ...................... 24

Customizing the SMART Sync Student Installation Package....................... 26

Deploying the Installation Packages............................................................. 27
 



 i i | CONTENTS
5 Setting Up SMART School Files ......................................................................... 29

Creating or Opening a SMART School File .................................................. 29

Locating SMART Sync Class List Server ..................................................... 31

Importing School Information........................................................................ 32

Entering Student, Teacher and Class Information........................................ 35

Entering Computer Lab Information.............................................................. 38

Entering Application Blocking Rules ............................................................. 40

Entering Internet Blocking Rules .................................................................. 41

Reviewing the SMART School File............................................................... 42

Specifying the Location of the SMART School File ...................................... 43

6 Configuring SMART Sync Student...................................................................... 45

Running the SMART Sync Student Configuration Tool ................................ 45

Automatically Configuring SMART Sync Student Installations ..................... 49

7 Configuring SMART Sync Class List Server ....................................................... 51

Stopping and Restarting SMART Sync Class List Server ............................ 51

Changing the SMART Sync Class List Server Port Number ........................ 54

A Customer Support ............................................................................................... 55

Online Information and Support.................................................................... 55

Training......................................................................................................... 55

Technical Support......................................................................................... 55

Shipping and Repair Status .......................................................................... 55

General Inquiries .......................................................................................... 56

Registration................................................................................................... 56
 



Chapter 1

Welcome
With SMART Sync, teachers in your school can manage their classrooms and 
communicate with and assist students without leaving their computers.

About This Guide
This guide explains how to install SMART Sync on your school’s computers and then 
use the administrator components of the software to centrally configure and maintain 
the SMART Sync installation.

This guide is intended for IT administrators and others experienced with installing, 
configuring and administering Windows® software in a networked environment. To 
use this guide, you must:

• Know IT terminology such as “registry” and “domain controller”

• Know how to complete basic administrative tasks in Windows operating systems 
such as opening the Control Panel or modifying the registry

• Have administrative privileges and access to your school’s servers

• Have the SMART Sync CD or access to the SMART Support website
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About SMART Sync
Using SMART Sync, teachers can monitor and control students’ computers using the 
Thumbnails view, which displays up-to-the-moment images of students’ screens. 
Teachers can customize the appearance of this view. In addition to viewing the 
thumbnails, teachers can do the following:

• Capture snapshots of a student’s screen

• Take control of a student’s computer

• Place a temporary lock on students’ computers

• Remotely shut down students’ computers

• Allow or block Internet access

• Allow or block the use of specific applications

Teachers can also use SMART Sync to communicate with their entire class, a group 
of students or an individual student. Teachers can broadcast their desktops, conduct 
polls, send messages to students and receive replies, send files to students and more.

Components
From an administrator’s perspective, SMART Sync consists of four components:

• SMART Sync Teacher: An application that resides on the teachers’ computers 
and allows them to connect with students and other teachers as teacher aides

• SMART Sync Student: An application that resides on the students’ computers 
and allows them to connect with teachers

• SMART Sync Class List Server: Server software that connects students 
and teachers

• SMART Sync Administrator Tool: An application that allows you to create and 
edit SMART School files, which are central repositories of student, teacher, class, 
computer lab and computer information, and application and Internet 
blocking rules

NOTES
• This guide refers to SMART Sync Teacher, Class List Server and 

Administrator Tool as the SMART Sync Teacher components.

• SMART Sync Class List Server and SMART Sync Administrator Tool are 
optional. You don’t need to install them to use SMART Sync Teacher and 
SMART Sync Student. However, there are benefits to installing them, which 
are explained in the remainder of this guide.
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SMART Sync Setup
The following diagram presents an example setup of the four software components of 
SMART Sync:

The following table defines the activities of each component in the setup:
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Component Activities

Administrator Tool • Creates and edits SMART School files

Teacher • Refers to the SMART School file for a centralized 
repository of class and computer lab information as well 
as application and Internet blocking rules

• Allows the teacher to connect with students’ computers

Student • Allows the student to connect with the teacher’s computer

Class List Server • Keeps a list of SMART Sync Teacher and Student 
installations running on the network and coordinates 
connections between installations
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NOTES
• Although this example includes only one installation of SMART Sync 

Administrator Tool, you can have multiple installations so that more than one 
administrator can create or edit the SMART School file.

• There are other ways for SMART Sync Student to connect to SMART Sync 
Teacher (see page 46).
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Installing 
SMART Sync
You can install SMART Sync on your school’s computers using the installation wizard, 
the command line interface or SMART Install Manager (using Windows Group Policy 
for deployment). Regardless of which tool you use, review the information in this 
chapter before proceeding with the installation.

Before Installing SMART Sync
Before installing SMART Sync, review the following information on display settings, 
network size and speed, and Internet connection firewalls.

Display Setting
SMART Sync works best when the teacher’s and students’ computers are set to the 
same screen resolution and color depth. However, the software makes adjustments 
for different color settings and resolutions. For example, if a broadcasting computer 
(either teacher or student) runs at a higher resolution than a viewing computer, scroll 
bars appear on the viewing computer so that you can view the entire higher-resolution 
screen.

Similarly, if a broadcasting computer has a higher color setting than a viewing 
computer, the broadcasting computer’s colors are reduced so that the user can see it 
at the viewing computer. For example, if a student’s computer has a higher color 
setting than the teacher’s computer, the teacher sees a Color Reduced message 
below the thumbnail. When the teacher views a live, full-screen image, the colors 
appear slightly degraded.

For information on how to change the display settings of your school’s monitors, see 
the instructions that came with the operating system.
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SMART Sync works best when the screen resolution is 1024 × 768. Refer to the 
following table for the optimal screen resolution and color depth for your school’s 
monitors.

Network Size and Speed
The preferred TCP/IP network configuration for SMART Sync is a switch or a 
switching hub that restricts network traffic to a particular segment of your local area 
network. In this configuration, other network traffic doesn’t affect your system and 
SMART Sync doesn’t slow down other segments of the network. Network activity is 
faster when the number of connected students is smaller.

TIP
Graphics-rich backgrounds on your students’ screens may slow SMART Sync’s 
performance. Performance is best if your students’ screens have simple, 
single-color backgrounds.

Screen Resolution High Color (16 bit) True Color (32 bit)

1024 × 768 or less Optimal Optimal

1152 × 864 Acceptable Acceptable

1280 × 1024 Acceptable Acceptable

1600 × 1200 Acceptable Not recommended

Network Type
Maximum Number of 
Students

10 Mbps 40

100 Mbps 80

Wireless (single 802.11 a/g access point) 30
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Internet Connection Firewalls
If you install SMART Sync on a computer that has an active Internet connection 
firewall, the firewall can cause network problems. If possible, set the firewall to allow 
network traffic from SMART Sync. If this doesn’t resolve the problem, ensure the 
following network communication ports are open:

Selecting a Tool
You can customize the SMART Sync installation packages using one of the 
following tools:

• Installation wizard

• Command line interface

• SMART Install Manager

The installation wizard is best if you’re installing SMART Sync on a small number of 
computers or if teachers and students are responsible for installing software on their 
own computers. For more information, see the SMART Sync 2009 Installation Guide 
(document 129772).

The command line interface is best if you prefer installing software using a command 
line interface rather than an GUI installation wizard, or if you use Windows Installer in 
conjunction with a third-party imaging or remote management software to automate 
the installation of software across your school’s network. For more information, see 
page 9.

SMART Install Manager is best if you’re deploying SMART Sync across a large 
network of teacher and student computers and prefer to use SMART Install Manager, 
rather than a command line interface, to customize the installation packages. You can 
then use third-party software to automate the installation of software across your 
school’s network. For more information, see page 21.

Port Purpose

5463 (TCP) Main Teacher-to-Student communications port

5485 (TCP) Main Teacher-to-Teacher communications port

5496 (UDP) Teacher discovery port

5491 (UDP) Broadcast port

5493 (UDP) Broadcast recovery port
 

http://www2.smarttech.com/kbdoc/129772
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Locating the Installation Packages
There are two installation packages (also known as .msi files) for SMART Sync:

Both installation packages are located on the SMART Sync CD. The Teacher 
installation package is located in the TeacherSetup folder, and the Student installation 
package is located in the StudentSetup folder.

Alternatively, you can download both packages from www2.smarttech.com/st/en-US/
Support/Downloads/Admin+tools/Sync2009Admin.htm.

Installation Package File Name

SMART Sync Teacher SMART Sync 2009.msi

SMART Sync Student SMART Sync Student 2009.msi
 

http://www2.smarttech.com/st/en-US/Support/Downloads/Admin+tools/Sync2009Admin.htm
http://www2.smarttech.com/st/en-US/Support/Downloads/Admin+tools/Sync2009Admin.htm


Chapter 3

Using the 
Command Line 
Interface
The SMART Sync installation packages contain all of the information that 
Windows Installer requires to install or remove the SMART Sync components. Run the 
.msi files from a command prompt to start Windows Installer and install or modify the 
software using available properties and parameters.

Completing SMART Sync Teacher 
Installation Tasks
Using the SMART Sync Teacher installation package, you can complete the following 
tasks from a command line interface:

• Installing or upgrading SMART Sync Teacher

• Removing SMART Sync Teacher

• Adding or removing components
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Installing or Upgrading SMART Sync Teacher
You can install or upgrade SMART Sync Teacher by following the instructions in 
this section.

To install or upgrade
SMART Sync Teacher

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\SMART Sync 2009.msi" [Properties] 
[Parameter] 

Where:

– [Path] is the path to the SMART Sync 2009.msi file.

– [Properties] is a set of properties you can include to customize the installation 
(see page 14).

– [Parameter] is the installation parameter (see page 18).

3. Press ENTER.

Windows Installer installs or upgrades the selected SMART Sync Teacher 
components.

Removing SMART Sync Teacher
In addition to installing or upgrading SMART Sync Teacher, you can remove it in Silent 
mode using Windows Installer.

To remove
SMART Sync Teacher

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\SMART Sync 2009.msi" /q

Where [Path] is the path to the SMART Sync 2009.msi file.

3. Press ENTER.

Windows Installer removes SMART Sync Teacher.

NOTE
This may take several minutes with no indication of activity or completion.
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Adding or Removing Components
After installing the SMART Sync Teacher on a computer, you may decide to add or 
remove components. For example, you may have initially installed SMART Sync 
Teacher on a computer and now want to install SMART Sync Class List Server and 
Administrator Tool on the same computer.

To add a component 1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\SMART Sync 2009.msi" 
[Installation properties] [Add properties] [Parameter] 

Where:

– [Path] is the path to the SMART Sync 2009.msi file.

– [Installation properties] are the INSTALL properties of the components 
already installed.

TIP
If SMART Sync Teacher is already installed, you don’t need to include the 
INSTALLTEACHER property. This is because this property is enabled 
by default.

– [Add properties] is the set of properties for the component you want to add:

See page 19 for examples.

– [Parameter] is the installation parameter (see page 18).

3. Press ENTER.

Windows Installer adds the component you specified.

Component Add Properties

Teacher INSTALLTEACHER="1"
REINSTALLMODE=voums
ADDLOCAL=Teacher

Class List Server INSTALLCLASSLISTSERVER="1"
REINSTALLMODE=voums
ADDLOCAL=ClassListServer

Administrator Tool INSTALLADMINTOOL="1"
REINSTALLMODE=voums
ADDLOCAL=AdminTool
 



12 | CHAPTER 3  –  USING THE COMMAND LINE INTERFACE
To remove a component 1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\SMART Sync 2009.msi" 
[Remove properties] [Parameter] 

Where:

– [Path] is the path to the SMART Sync 2009.msi file.

– [Remove properties] is the set of properties for the component you want 
to remove:

See page 19 for an example.

– [Parameter] is the installation parameter (see page 18).

3. Press ENTER.

Windows Installer removes the component you specified.

Completing SMART Sync Student 
Installation Tasks
Using the SMART Sync Student installation package, you can complete the following 
tasks from a command line interface:

• Installing or upgrading SMART Sync Student

• Removing SMART Sync Student

Component Remove Properties

Teacher INSTALLTEACHER=""
REINSTALLMODE=voums
REMOVE=Teacher

Class List Server INSTALLCLASSLISTSERVER=""
REINSTALLMODE=voums
REMOVE=ClassListServer

Administrator Tool INSTALLADMINTOOL=""
REINSTALLMODE=voums
REMOVE=AdminTool
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Installing or Upgrading SMART Sync Student
You can install or upgrade SMART Sync Student by following the instructions in 
this section.

To install or upgrade
SMART Sync Student

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\SMART Sync Student 2009.msi" 
[Properties] [Parameter] 

Where:

– [Path] is the path to the SMART Sync Student 2009.msi file.

– [Properties] is a set of properties you can include to customize the installation 
(see page 17).

– [Parameter] is the installation parameter (see page 18).

3. Press ENTER.

Windows Installer installs or upgrades SMART Sync Student.

Removing SMART Sync Student
In addition to installing or upgrading SMART Sync Student, you can remove it in Silent 
mode using Windows Installer.

To remove
SMART Sync Student

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\SMART Sync Student 2009.msi" /q

Where [Path] is the path to the SMART Sync Student 2009.msi file.

3. Press ENTER.

Windows Installer removes SMART Sync Student.

NOTE
This may take several minutes with no indication of activity or completion.
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Properties

SMART Sync Teacher Installation Package
The following are properties for the SMART Sync Teacher installation package:

• INSTALLDIR 

NOTE
If you don’t include this property, Windows Installer installs the programs in 
%PROGRAMFILES%\SMART Technologies\SMART Sync 2009.

• INSTALLTEACHER 

• INSTALLCLASSLISTSERVER 

• INSTALLADMINTOOL 

• ISX_SERIALNUM 

NOTE
If you don’t provide a product key during installation, the activation dialog box 
appears when you start SMART Sync Teacher. Using this dialog box, enter 
the product key within 30 days of installing the software.

Value Enter this value to:

[String] Specify the path to your preferred folder for the SMART 
Sync Teacher, Class List Server and Administrator Tool 
programs.

Value Enter this value to:

1 (Default) Install SMART Sync Teacher.

[Null] Not install SMART Sync Teacher.

Value Enter this value to:

1 Install SMART Sync Class List Server.

[Null] (Default) Not install SMART Sync Class List Server.

Value Enter this value to:

1 Install SMART Sync Administrator Tool.

[Null] (Default) Not install SMART Sync Administrator Tool.

Value Enter this value to:

[String] Specify the 22-character product key you received from 
SMART Technologies.
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• INSTALL_SPU 

• PRODUCT_NOTIFICATION 

NOTE
This property is only applicable if you install SPU.

• SPU_TIME_FRAME 

NOTES
– By debault, SPU checks for product updates every 30 days. You can set 

SPU to check for product updates at intervals of one to 60 days.

– This property is only applicable if you install SPU.

• SCHOOLFILE 

NOTE
To create a SMART School file, you need SMART Sync Administrator Tool. 
For more information, see page 29.

Value Enter this value to:

1 Install SMART Product Update (SPU).

Value Enter this value to:

1 (Default) Notify the user when updates are available from SPU.

[Null] Not notify the user when updates are available from SPU.

Value Enter this value to:

[Integer] Specify the time in days between SPU product update 
checks.

Value Enter this value to:

[String] Specify the path to the SMART School file.
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• TRANSFORMS 

NOTE
If you don’t include this property, Windows Installer installs SMART Sync 
Teacher in English (U.S.).

Value Enter this value to:

1033.mst Install SMART Sync Teacher in English (U.S.).

2057.mst Install SMART Sync Teacher in English (UK).

1025.mst Install SMART Sync Teacher in Arabic.

2052.mst Install SMART Sync Teacher in Chinese (simplified).

1043.mst Install SMART Sync Teacher in Dutch.

1036.mst Install SMART Sync Teacher in French.

1031.mst Install SMART Sync Teacher in German.

1032.mst Install SMART Sync Teacher in Greek.

1040.mst Install SMART Sync Teacher in Italian.

1046.mst Install SMART Sync Teacher in Portuguese (Brazil).

2070.mst Install SMART Sync Teacher in Portuguese (Portugal).

1049.mst Install SMART Sync Teacher in Russian.

1034.mst Install SMART Sync Teacher in Spanish.

2058.mst Install SMART Sync Teacher in Spanish (Mexico).

1055.mst Install SMART Sync Teacher in Turkish.
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SMART Sync Student Installation Package
The following are properties for the SMART Sync Student installation package:

• INSTALLDIR 

NOTE
If you don’t include this property, Windows Installer installs the program in 
%PROGRAMFILES%\SMART Technologies\SMART Sync Student.

• CREATE_SHORTCUTS 

NOTE
If you don’t include this property, Windows Installer includes the shortcuts.

• PATHTOINI 

NOTES
– You can install SMART Sync Student using the wizard for one installation, 

and then run the SMART Sync Student Configuration Tool to create a 
SyncClient.ini file. You can then refer to the file in this property to 
automatically configure all other installations (see page 45).

– If you don’t include this property, Windows Installer refers to the 
SyncClient.ini file in the same folder as the .msi file.

Value Enter this value to:

[String] Specify the path to your preferred folder for the SMART 
Sync Student program.

Value Enter this value to:

1 (Default) Include shortcuts to SMART Sync Student in the Start menu 
and on the desktop.

[Null] Not include shortcuts to SMART Sync Student in the Start 
menu and on the desktop.

Value Enter this value to:

[String] Specify the path to the SyncClient.ini file.
 



18 | CHAPTER 3  –  USING THE COMMAND LINE INTERFACE
Parameters
Following are the properties for the SMART Sync Teacher and SMART Sync Student 
installation packages:

Examples

SMART Sync Teacher Installation Package

Initial Installation
The following example installs SMART Sync Teacher but not SMART Sync 
Class List Server or Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" /qb

The following example installs SMART Sync Class List Server and Administrator Tool 
but not SMART Sync Teacher:

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" 
INSTALLCLASSLISTSERVER="1" INSTALLADMINTOOL="1" /qb

Parameter Use this parameter to:

/q Hide the installation wizard.

(This is Silent mode.)

/qb Show a basic installation wizard.

/qb! Show a basic installation wizard without a Cancel button.

/qb+ Show a basic installation wizard with a dialog box signaling the 
end of the installation.

/qb+! Show a basic installation wizard without a Cancel button but 
with a dialog box signaling the end of the installation.

/qr Show a reduced installation wizard.

/qf Show the full installation wizard, including a dialog box signaling 
the end of the installation or the Fatal Error, User Exit or Exit 
dialog box.

/qn Hide the installation wizard and the dialog box signaling the end 
of the installation.

/qn+ Hide the installation wizard but show the dialog box signaling 
the end of the installation.
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Component Addition
The following example installs SMART Sync Administrator Tool on a computer that 
already has SMART Sync Teacher (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" 
INSTALLADMINTOOL="1" REINSTALLMODE=voums ADDLOCAL=AdminTools 
/qb

The following example installs SMART Sync Teacher on a computer that already has 
SMART Sync Administrator Tool (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" 
INSTALLADMINTOOL="1" INSTALLTEACHER="1" REINSTALLMODE=voums 
ADDLOCAL=Teacher /qb

The following example installs SMART Sync Class List Server on a computer that 
already has SMART Sync Teacher and Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" 
INSTALLADMINTOOL="1" INSTALLCLASSLISTSERVER="1" 
REINSTALLMODE=voums ADDLOCAL=ClassListServer/qb

Component Removal
The following example removes SMART Sync Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2009.msi" 
INSTALLADMINTOOL="" REINSTALLMODE=voums REMOVE=AdminTools
/qb

SMART Sync Student Installation Package
The following example installs SMART Sync Student but prevents the computer from 
restarting automatically after the installation is complete:

msiexec /i "D:\StudentSetup\SMART Sync Student 2009.msi" /qb 
-norestart
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Using SMART 
Install Manager
SMART Install Manager allows you to customize SMART Sync Teacher and 
SMART Sync Student installation packages (also known as .msi files) by publishing 
.mst files. You can then deploy the .msi and .mst files to the teacher and student 
computers on your school’s network using Windows Group Policy.

Installing SMART Install Manager
SMART Install Manager is included on the SMART Sync CD. You can install the 
software from the CD.

OR

You can download and install SMART Install Manager from the SMART Support 
website.

To install the software
from the CD

1. Insert the SMART Sync CD in your computer’s CD drive.

The SMART Sync Classroom Management Software dialog box appears.

NOTE
If the dialog box doesn’t appear, navigate to and open 
[CD Drive]\CDBrowser.exe in Windows Explorer.

2. Click Administrator Preparation and Tools, and then click 
Install SMART Install Manager.

The SMART Install Manager installation wizard appears.

3. Follow the on-screen instructions to install SMART Install Manager.
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To install the software
from the website

1. In a browser, navigate to www2.smarttech.com/st/en-US/Support/Downloads/
Admin+tools/AdminToolsNB.htm.

2. Click SMART Install Manager to download the SMART Install Manager 
installation wizard to your computer.

3. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

4. Follow the on-screen instructions to install SMART Install Manager.

Working with SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the 
desktop and in the Start menu under All Programs > SMART Technologies > 
SMART Install Manager.

With SMART Install Manager, you can do the following:

• Open an installation package.

• Save your changes to the installation package.

• Publish your changes to the installation packages as an .mst file.

Opening an Installation Package
To customize an installation package, you must open its .msi file in 
SMART Install Manager by doing one of the following:

• Select File > Open.

• Click .

• Click and drag the .msi file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking 
, or on CDs or DVDs by clicking .

TIP
All installation packages that you’ve previously opened in SMART Install Manager 
appear in the Unmodified Packages tab.
 

http://www2.smarttech.com/st/en-US/Support/Downloads/Admin+tools/AdminToolsNB.htm
http://www2.smarttech.com/st/en-US/Support/Downloads/Admin+tools/AdminToolsNB.htm
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After you open an installation package, a set of pages for that installation package 
appear in SMART Install Manager:

Customize the installation package using the controls in these pages. See page 24 for 
information on the SMART Sync Teacher installation package controls and page 26 
for information on the SMART Sync Student installation package controls.

Saving Your Changes
After customizing an installation package, you can save your changes as an XML file 
by selecting File > Save As. When you next start SMART Install Manager, you can 
load the XML file by selecting File > Open or by opening the .msi file and then 
selecting File > Import.

TIP
All XML files that you create or open in SMART Install Manager appear in the 
Modified Packages tab of the Welcome page.

Publishing Your Changes as an .mst File
The final step in using SMART Install Manager to customize an installation package is 
to publish your changes as an .mst file. Do this by selecting File > Publish, and then 
using the dialog box to define a location for and create the .mst file.
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Customizing the SMART Sync Teacher 
Installation Package
To customize the SMART Sync Teacher installation package, open the 
SMART Sync 2009.msi file in SMART Install Manager (see page 22), and then 
complete the following procedures.

To set
installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for the 
SMART Sync Teacher, Class List Server and Administrator Tool programs.

NOTE
If you don’t specify a folder, Windows Installer installs the programs in 
%PROGRAMFILES%\SMART Technologies\SMART Sync 2009.

3. In the Language drop-down list, select your preferred language for the 
SMART Sync Teacher user interface.

4. Select the Install SMART Sync Class List Server check box to install 
SMART Sync Class List Server.

5. Select the Install SMART Sync Administrator Tool check box to install 
SMART Sync Administrator Tool.

To specify
the product key

1. Click Product Key.

The Product Key page appears.

2. In the Product key box, type the 22-character product key you received from 
SMART Technologies to activate SMART Sync Teacher.

NOTE
If you don’t provide a product key during installation, the activation dialog box 
appears when you start SMART Sync Teacher. Using this dialog box, enter 
the product key within 30 days of installing the software.
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To configure SPU 1. Click SMART Product Update (SPU) Options.

The SMART Product Update (SPU) Options page appears.

2. Select the Install SMART Product Update check box to install SPU.

3. In the Check for updates box, type the number of days between SPU product 
update checks.

NOTE
By default, SPU checks for product updates every 30 days. You can set SPU 
to check for product updates at intervals of one to 60 days.

4. Select the Notify users about SMART product updates check box to notify the 
user when product updates are available.

To set SMART School
file options

1. Click SMART School File.

The SMART School File page appears.

2. In the SMART School file box, type the path to the SMART School file.

NOTE
To create a SMART School file, you need SMART Sync Administrator Tool. 
For more information, see page 29.
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Customizing the SMART Sync Student 
Installation Package
To customize the SMART Sync Student installation package, open the 
SMART Sync Student 2009.msi file in SMART Install Manager (see page 22), and 
then complete the following procedures.

To set
installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for the 
SMART Sync Student program.

NOTE
If you don’t specify a folder, Windows Installer installs the program in 
%PROGRAMFILES%\SMART Technologies\SMART Sync Student.

3. Select the Install Start menu and desktop shortcuts check box to install 
shortcuts to SMART Sync Student in the Start menu and on the desktop.

To set configuration
file options

1. Click Student Configuration.

The Student Configuration page appears.

2. In the Configuration file box, type the path to the SyncClient.ini file.

NOTE
You can install SMART Sync Student using the wizard for one installation, and 
then run the SMART Sync Student Configuration Tool to create a 
SyncClient.ini file. You can then refer to the file in this property to 
automatically configure all other installations (see page 45).
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Deploying the Installation Packages
After publishing .mst files for the SMART Sync Teacher and SMART Sync Student 
installation packages, you can deploy these installation packages using Windows 
Group Policy on your server.

NOTE
These procedures may vary depending on your version of Windows operating 
system and your system preferences.

To deploy an
installation package

1. Copy the .msi file and the .mst file you published using SMART Install Manager 
(see page 23) to \\[Domain Controller]\NETLOGON, where [Domain Controller] 
is your school’s domain controller.

2. Open the Control Panel.

3. Double-click Administrative Tools.

4. Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

5. Right-click your school’s domain, and then select Properties.

The Properties dialog box appears.

6. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

7. Navigate to and open Computer Configuration\Software Settings.

8. Right-click Software Installation, and then select New > Package.

9. Navigate to and select the .msi file from step 1.

10. In the Deploy Software section, click Advanced, and then click OK.

11. Click the Modifications tab, and then click Add.

12. Navigate to and select the .mst file from step 1.

13. Click OK to apply the .mst file to the .msi file.

14. Close all open windows and dialog boxes.

When each computer on the domain next starts, it automatically installs the 
software in Silent mode with the customizations defined in the .mst file.
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To remove a deployed
installation package

1. Open the Control Panel.

2. Double-click Administrative Tools.

3. Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

4. Right-click your school’s domain, and then select Properties.

The Properties dialog box appears.

5. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

6. Navigate to and open Computer Configuration\Software Settings\
Software Installation.

7. Right-click the software you want to remove, and then select All Tasks > 
Remove.

8. Select Immediately uninstall the software from users and computers, and 
then click OK.

The next time each computer on the domain starts, it automatically removes 
the software.
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Setting Up 
SMART School Files
SMART Sync Administrator Tool allows you to create and edit SMART School 
(.school) files.

A SMART School file contains information about students, teachers, classes and 
computer labs in your school as well as rules that teachers can apply to block student 
access to applications and websites. If you specify the location of a SMART School 
file in SMART Sync Teacher, teachers can use this information to connect to 
their students.

In most situations, you only need to create one SMART School file per school so that 
all teachers and students in the school can connect to each other. For security 
reasons, when you create the file, save it in a location accessible to teachers and 
network administrators, but not to students. After creating the file, you can update it at 
any time.

Creating or Opening a SMART School File
The first step in setting up a SMART School file is to start SMART Sync Administrator 
Tool, and then create or open the file.

To create a new
SMART School file

1. Double-click the SMART Sync Administrator Tool 2009 icon on the desktop.

OR

Select Start > All Programs > SMART Technologies > SMART Sync > 
SMART Sync Administrator Tool 2009.

The SMART Sync Administrator Tool window appears.

2. Click School File.

3. Click Create a new SMART School file and save it as.
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4. Click Browse.

The Select School File Location dialog box appears.

5. Navigate to the folder where you want to create the SMART School file.

IMPORTANT
For security reasons, create the SMART School file in a folder accessible to 
teachers and network administrators, but not to students.

6. Type a name for the SMART School file in the File name box.

7. Click Save.

The Select School File Location dialog box closes, and the path to the 
SMART School file appears in the box below the Create a new SMART School 
file and save it as option.

To open an existing
SMART School file

1. Double-click the SMART Sync Administrator Tool 2009 icon on the desktop.

OR

Select Start > All Programs > SMART Technologies > SMART Sync > 
SMART Sync Administrator Tool 2009.

The SMART Sync Administrator Tool window appears.

2. Click School File.

3. Click Edit the existing SMART School file in this location.

4. Click Browse.

The Open School File dialog box appears.

5. Navigate to and select the SMART School file.

6. Click Open.

The Open School File dialog box closes, and the path to the SMART School file 
appears in the box below the Edit the existing SMART School file in this 
location option.
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Locating SMART Sync Class List Server
You must enter the host name or IP address of the computer hosting SMART Sync 
Class List Server in your SMART School files.

To locate SMART Sync
Class List Server

1. Ensure SMART Sync Class List Server is running (see page 51).

2. Create or open a SMART School file (see page 29).

3. Click Class List Server.

4. Type the host name or IP address of the computer hosting SMART Sync Class List 
Server in the Enter the IP address or hostname of your Class List Server box.

NOTES
– SMART Sync Class List Server uses the 46200 port number by default. 

However, you can change the port number (see page 54). If you do so, 
you must include the port number after the host name or IP address (for 
example, 127.0.0.1:46201).

– If your network uses Dynamic Host Configuration Protocol (DHCP), refer 
to the SMART Sync Class List Server computer by host name rather than 
by IP address.

5. Click Test Connection to test the connection to the SMART Sync Class List 
Server computer.
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Importing School Information
You can manually enter students, teachers, classes and computer labs in SMART 
School files using SMART Sync Administrator Tool. Alternatively, you can import this 
information from CSV (.csv) files.

The following is an example:

ID,Last Name,First Name,Title,Class ID,Class Title,Type
S001,Adams,John,,Eng,English,0
S002,Brook,Sally,,Eng,English,0
S003,Williams,Ronald,,Eng,English,0
T001,Johnson,Adam,Mr.,Eng,English,1

To create the student,
teacher and class CSV file

1. Using Microsoft® Excel® or another application that can generate CSV files, 
create a spreadsheet with seven columns:

Column Name Req’d? Type Description

Person ID Yes String The student’s or the teacher’s unique 
ID.

NOTE
The ID must be unique to the 
student or teacher. For example, 
a student and a teacher can’t 
both have the ID 123456.

Last Name Yes String The student’s or the teacher’s last 
name.

First Name Yes String The student’s or the teacher’s first 
name.

Title No String The student’s or the teacher’s title 
(for example, Mr., Ms., or Dr.).

NOTE
SMART Sync Administrator Tool 
only stores this information for 
teachers.
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NOTES
– The first row of the spreadsheet must contain the column names as listed 

in the previous table.

– The string columns can contain any character except commas (,).

The following is an example:

2. Save the spreadsheet as a CSV file.

NOTE
See the application’s Help for instructions on saving spreadsheets as 
CSV files.

Class ID No String The unique ID of the student’s or the 
teacher’s class.

Class Title No String The name of the student’s or the 
teacher’s class.

If appropriate, include the class’s 
period to distinguish it from other 
classes.

Type Yes Integer
(0 or 1)

0 for a student.

OR

1 for a teacher.

Column Name Req’d? Type Description
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To create the
computer lab CSV file

1. Using Microsoft Excel or another application that can generate CSV files, create a 
spreadsheet with four columns:

NOTES
– The first row of the spreadsheet must contain the column names as listed 

in the previous table.

– The string columns can contain any character except commas (,).

The following is an example:

Column Name Req’d? Type Description

Hostname Yes String The computer’s host name or IP 
address (for example, 127.0.0.1).

NOTE
If your network uses DHCP, refer 
to the computer by host name 
rather than by IP address.

Workstation 
Name

No String The computer’s name.

Lab ID Yes String The unique ID of the computer’s lab.

Lab Title Yes String The name of the computer’s lab.
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2. Save the spreadsheet as a CSV file.

NOTE
See the application’s Help for instructions on saving spreadsheets as 
CSV files.

To import the CSV files 1. Create or open a SMART School file (see page 29).

2. Click Import Information.

3. Click Browse to the right of the Student, Teacher, Class CSV file Location box.

The Open Classes CSV File dialog box appears.

4. Navigate to and select the student, teacher and class CSV file.

5. Click Open.

The Open Classes CSV File dialog box closes, and the path to the student, 
teacher and class CSV file appears in the Student, Teacher, Class CSV file 
Location box.

6. Click Browse to the right of the Computer, Lab CSV File Location box.

The Open Labs CSV File dialog box appears.

7. Navigate to and select the computer lab CSV file.

8. Click Open.

The Open Labs CSV File dialog box closes, and the path to the computer lab CSV 
file appears in the Computer, Lab CSV File Location box.

Entering Student, Teacher and Class 
Information
You can import student, teacher, and class information from a CSV file (see page 32). 
Alternatively, you can manually enter student, teacher and class information in a 
SMART School file using SMART Sync Administrator Tool.
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Entering Student Information

To add a student 1. Create or open a SMART School file (see page 29).

2. Click Students.

3. Click Add Student.

A new row appears in the table.

4. Type the student’s last name in the Last Name column.

5. Type the student’s first name in the First Name column.

6. Type the student’s ID in the Student ID column.

NOTE
SMART Sync Administrator Tool generates a random ID for the student if you 
don’t specify one.

To remove a student 1. Open a SMART School file (see page 29).

2. Click Students.

3. Select the student’s row in the table.

4. Click Remove Student.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.
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Entering Teacher Information

To add a teacher 1. Create or open a SMART School file (see page 29).

2. Click Teachers.

3. Click Add Teacher.

A new row appears in the table.

4. Type the teacher’s last name in the Last Name column.

5. Type the teacher’s first name in the First Name column.

6. Type the teacher’s title in the Title column (for example, Mr., Ms. or Dr.).

To remove a teacher 1. Open a SMART School file (see page 29).

2. Click Teachers.

3. Select the teacher’s row in the table.

4. Click Remove Teacher.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.

Entering Class Information

To add a class 1. Create or open a SMART School file (see page 29).

2. Click Classes.

3. Click Add.

A new row appears in the table.

4. Type a name for the class in the Class Name column (for example, 
5th Grade Math).

If appropriate, include the class’s period to distinguish it from other classes.
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5. Select the name of a teacher or student you want to include in the class in the 
All Students and Teachers list, and then click  to move it to the 
Class Members list.

NOTES
– In the All Students and Teachers and Class Members lists, teachers’ 

names appear in red text and students’ names appear in black text.

– To remove teachers or students from a class, select their names in the 
Class Members list, and then click  to move them to the All Students 
and Teachers list.

6. Repeat step 5 for each teacher or student that you want to add to the class.

To remove a class 1. Open a SMART School file (see page 29).

2. Click Classes.

3. Select the class’s row in the table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.

Entering Computer Lab Information
You can import computer lab information from a CSV file (see page 32). Alternatively, 
you can manually enter computer lab information in a SMART School file using the 
Computer Labs section of SMART Sync Administrator Tool.

To add a computer lab 1. Create or open a SMART School file (see page 29).

2. Click Computer Labs.

3. Click Add.

A new row appears in the computer lab table.

4. Type a name for the computer lab in the Lab Name column (for example, 
Main Lab).
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5. Click Add Computer.

A new row appears in the computer table.

6. Type the host name or IP address of the computer in the Hostname column (for 
example, 127.0.0.1).

NOTE
If your network uses DHCP, refer to the computer by host name rather than by 
IP address.

7. Type the name of the computer in the Workstation Name column (for example, 
Main Lab WS1).

8. Repeat steps 5 to 7 for each computer you want to add to the computer lab.

NOTE
To remove a computer from the computer lab, select the computer, and then 
click Remove Computer.

To remove a computer lab 1. Open a SMART School file (see page 29).

2. Click Computer Labs.

3. Select the computer lab’s row in the computer lab table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.
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Entering Application Blocking Rules
An application blocking rule allows teachers either to allow specific applications and 
block all others or to block specific applications and allow all others. For example, an 
English teacher could allow access to Microsoft Word but block access to all other 
applications during the writing of an English paper.

To add an
application blocking rule

1. Create or open a SMART School file (see page 29).

2. Click Application Blocking.

3. Click Add.

A new row appears in the application blocking rule table.

4. Type a name for the rule in the Rule Name column (for example, English Paper).

5. Click Block all applications except those listed below if you want to block all 
applications except those you specify.

OR

Click Allow all applications except those listed below if you want to allow all 
applications except those you specify.

6. Click Add Application.

The Select Application dialog box appears.

7. Navigate to and select the application’s executable (.exe) file.

TIP
Most executable files are located in C:\Program Files.

8. Click Open.

The Select Application dialog box closes, and a new row appears in the 
application table.

9. Type a name for the application in the Display Name column if you don’t want to 
use the default name.

10. Repeat steps 6 to 9 for each application that you want to add to the application 
blocking rule.

NOTE
To remove an application from the application blocking rule, select the 
application, and then click Remove Application.
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To remove an
application blocking rule

1. Open a SMART School file (see page 29).

2. Click Application Blocking.

3. Select the application blocking rule’s row in the application blocking rule table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.

Entering Internet Blocking Rules
An Internet blocking rule allows teachers either to allow specific websites and block all 
others or to block specific websites and allow all others. For example, a history 
teacher could block access to Wikipedia® during the writing of a history paper.

To add an
Internet blocking rule

1. Create or open a SMART School file (see page 29).

2. Click Internet Blocking.

3. Click Add.

A new row appears in the Internet blocking rule table.

4. Type a name for the rule in the Rule Name column (for example, History Paper).

5. Click Block all websites except those listed below if you want to block all 
websites except those you specify.

OR

Click Allow all websites except those listed below if you want to allow all 
websites except those you specify.

6. Click Add Website.

A new row appears in the website table.
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7. Type the address of the website in the Website Address column (for example, 
www.wikipedia.org).

8. Repeat steps 6 to 7 for each website that you want to add to the Internet blocking 
rule.

NOTE
To remove a website from the Internet blocking rule, select the website, and 
then click Remove Website.

To remove an
Internet blocking rule

1. Open a SMART School file (see page 29).

2. Click Internet Blocking.

3. Select the Internet blocking rule’s row in the Internet blocking rule table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP
Select the Don’t warn me again this session check box to prevent the 
Confirm Deletion dialog box from reappearing for the remainder of 
the session.

Reviewing the SMART School File
After setting up a SMART School file, you can review it in the Summary section and 
then close SMART Sync Administrator Tool to save the file. You should complete the 
following tasks before reviewing and saving the file:

• Locate SMART Sync Class List Server (see page 31).

• Import school information (see page 32).

OR

Enter student, class and teacher information (see page 35) and computer lab 
information (see page 38).

• Enter application blocking rules (see page 40).

• Enter Internet blocking rules (see page 41).
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To review the
SMART School file

1. Open a SMART School file (see page 29).

2. Click Summary.

If any warnings appear, read them and take the appropriate actions.

3. Click Exit.

Specifying the Location of the 
SMART School File
When you install SMART Sync Teacher, you can specify the location of the 
SMART School file (see page 14 and page 24). If you don’t specify the location of the 
SMART School file during installation or need to change it afterwards, you can do so 
in SMART Sync Teacher.

To specify the location of
the SMART School file

1. Start SMART Sync Teacher.

2. Select Options > Preferences.

The Preferences dialog box appears.

3. In the General tab, click Browse.

The Open dialog box appears.

4. Navigate to and select the SMART School file.

5. Click Open.

The Open dialog box closes, and the path to the SMART School file appears in 
the School File Location box.

6. Click OK, and then close SMART Sync Teacher.

The next time the teacher starts SMART Sync Teacher, the Welcome to 
SMART Sync – Teacher and Class Selection dialog box will include teachers and 
classes from the SMART School file.

NOTE
(Administered) appears beside classes from the SMART School file in the 
Welcome to SMART Sync – Teacher and Class Selection dialog box.
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Chapter 6

Configuring 
SMART Sync 
Student
Use SMART Sync Student Configuration Tool to configure SMART Sync Student. The 
tool creates a new file, SyncClient.ini, which you can then use to configure other 
SMART Sync Student installations without running the SMART Sync Student 
Configuration Tool each time.

Running the SMART Sync Student 
Configuration Tool
If you want to configure a SMART Sync Student installation, you can manually run the 
SMART Sync Student Configuration Tool.

To run the
SMART Sync Student

Configuration Tool

1. Select Start > All Programs > SMART Technologies > SMART Sync >
SMART Sync Student Configuration Tool 2009.

OR

Navigate to and open %PROGRAMFILES%\SMART Technologies\
SMART Sync Student\StudentConfig.exe.

The SMART Sync Student Configuration Tool dialog box appears.

2. Click Next.
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3. Click one of the following options:

NOTE
If you click Hidden from students, the student won’t be able to do the 
following:

– Connect to a teacher by selecting his or her name from a list

– Manually start SMART Sync Student

– Manually enter an ID after starting SMART Sync Student

The relevant controls in SMART Sync Student Configuration Tool will be 
disabled or hidden.

4. Click one of the following options:

Option Click this option to:

Visible to students Show the SMART Sync user interface to 
the student.

Hidden from students Hide the SMART Sync user interface from 
the student.

Option Click this option to:

Allows the student to 
select from a list of 
available teachers

Allow the student to select a teacher from a list.

NOTE
This option is disabled if you clicked 
Hidden from student in step 3.

Automatically connects 
with this Teacher ID

Connect SMART Sync to a specific teacher through 
the teacher’s ID.

Type the ID in the box to the right of the option.

Automatically connects 
with this hostname or IP 
address

Connect SMART Sync to a specific teacher through 
the host name or IP address.

Type the host name or IP address in the box to the 
right of the option.

NOTE
If your network uses DHCP, refer to the 
computer by host name rather than by 
IP address.
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5. If the computer has multiple network adapters, click Network Adapter Selection 
to specify the order of the network adapters.

6. Click Next.

7. Clear the Start SMART Sync automatically… check box if you don’t want 
SMART Sync Student to start when the student first logs on.

NOTE
This check box is disabled if you selected Hidden from student in step 3.

8. Select the student’s language in the Language drop-down list.

9. Select the following check boxes:

NOTE
These check boxes aren’t visible if you clicked Hidden from student in 
step 3.

10. Click Next.

Uses this Class List 
Server hostname or IP 
address

Connect SMART Sync to a specific teacher using 
SMART Sync Class List Server.

Type the host name or IP address of the SMART 
Sync Class List Server computer in the box to the 
right of the option.

NOTE
If your network uses DHCP, refer to the SMART 
Sync Class List Server computer by host name 
rather than by IP address.

Check Box Select this check box to:

Ask questions Allow the student to ask questions through 
SMART Sync.

Chat Allow the student to chat with other students 
through SMART Sync.

Submit files Allow the student to submit files through 
SMART Sync.

Exit the Student program Allow the student to close SMART Sync Student.

Option Click this option to:
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11. Click one of the following options:

12. Click Next.

13. Click one of the following options:

14. Click Next.

15. Click one of the following options:

Option Click this option to:

Student Controlled Allow the student to enter an ID when SMART Sync 
Student starts.

NOTE
This option is disabled if you clicked 
Hidden from student in step 3.

The following Enter a specific student ID.

Type the ID in the box to the right of the option.

Found in this 
Active Directory field…

Find the student ID in an Active Directory® directory 
service field of the student’s login account.

Type the Active Directory directory service field 
name in the box to the right of the option.

Anonymous Allow the student to use SMART Sync Student 
without entering an ID.

Option Click this option to:

My Documents folder Store files the teacher shares with the student in the 
My Documents folder.

Custom folder Store files in another folder.

Type the path to the folder in the box below the 
option.

Option Click this option to:

No security Allow any teacher with SMART Sync Teacher to 
connect to the student.

Allow only teachers with 
this class password

Allow only teachers who enter a specified password 
in SMART Sync Teacher to connect to the student.

Type the password in the two boxes to the right of 
the option.

Allow only Teachers who 
are part of the following 
group(s)

Allow only teachers in certain groups to connect to 
the student.

Select the groups in the box below the option.
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16. Click Next.

17. Click Finish.

The Restart Required to Apply Settings message appears.

18. Click OK.

Automatically Configuring SMART Sync 
Student Installations
After you configure one SMART Sync Student installation, copy its SyncClient.ini file 
to a central location on your network. (The SyncClient.ini file is located in 
%PROGRAMFILES%\SMART Technologies\SMART Sync Student.) You can then:

• Copy the file to other SMART Sync Student installations to configure them 
automatically without running the configuration tool.

• Refer to the file when installing SMART Sync Student using the command line 
interface (see page 14) or SMART Install Manager (see page 24).
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Chapter 7

Configuring 
SMART Sync 
Class List Server
SMART Sync Class List Server is a Windows service that connects SMART Sync 
Teacher and SMART Sync Student installations in your school.

In most situations, you don’t need to make any changes to SMART Sync Class List 
Server after installation. However, in some situations, you may need to do 
the following:

• Stop and restart SMART Sync Class List Server.

• Change the SMART Sync Class List Server port number.

NOTE
These procedures may vary depending on your version of Windows operating 
system and your system preferences.

Stopping and Restarting SMART Sync 
Class List Server
SMART Sync Class List Server starts automatically after you install it and each time 
you turn on the computer. You can manually stop and then restart SMART Sync Class 
List Server if necessary.
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Stopping SMART Sync Class List Server

To stop
Class List Server

from a command prompt

1. Open a Command Prompt window.

2. Navigate to the folder containing the SMART Sync Class List Server executable 
file.

NOTE
In most installations, this folder is C:\Program Files\SMART Technologies\
SMART Sync 2009.

3. Type the following command:

SMARTSyncClassListServer.exe -stop

4. Press ENTER.

SMART Sync Class List Server stops.

To stop
Class List Server

from the Services window

1. Open the Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window appears.

4. Scroll to and select SMART Sync Class List Server.

5. Click Stop.

OR

Click .

SMART Sync Class List Server stops.
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Restarting SMART Sync Class List Server

To restart
Class List Server

from a command prompt

1. Open a Command Prompt window.

2. Navigate to the folder containing the SMART Sync Class List Server executable 
file.

NOTE
In most installations, this folder is %PROGRAMFILES%\
SMART Technologies\SMART Sync 2009.

3. Type the following command:

SMARTSyncClassListServer.exe -start

4. Press ENTER.

SMART Sync Class List Server starts.

To restart
Class List Server

from the Services window

1. Open the Control Panel.

2. Switch to Classic view if necessary, and then double-click Administrative Tools.

3. Double-click Services.

The Services window appears.

4. Scroll to and select SMART Sync Class List Server.

5. Click Start.

OR

Click .

SMART Sync Class List Server starts.
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Changing the SMART Sync 
Class List Server Port Number
The default port number of SMART Sync Class List Server is 46200. You can change 
the port number if necessary.

To change the
port number

1. Stop SMART Sync Class List Server (see page 52).

2. Open a Command Prompt window.

3. Navigate to the folder containing the SMART Sync Class List Server executable 
file.

NOTE
In most installations, this folder is %PROGRAMFILES%\
SMART Technologies\SMART Sync 2009.

4. Type the following command:

SMARTSyncClassListServer.exe -u

5. Press ENTER.

The SMART Sync Class List Server service uninstalls.

6. Type the following command:

SMARTSyncClassListServer.exe -i [Port number]

7. Press ENTER.

The SMART Sync Class List Server service reinstalls with the new port number.

8. Restart SMART Sync Class List Server (see page 53).
 



Appendix A

Customer Support
Online Information and Support
Visit www.smarttech.com/support to view and download user’s guides, how-to and 
troubleshooting articles, software and more.

Training
Visit www.smarttech.com/trainingcenter for training materials and information about 
our training services.

Technical Support
If you experience difficulty with your SMART product, please contact your local 
reseller before contacting SMART Technical Support. Your local reseller can resolve 
most issues without delay.

NOTE
To locate your local reseller, visit www2.smarttech.com/st/en-US/Where+to+Buy.

All SMART products include online, telephone, fax and e-mail support:

Shipping and Repair Status
Contact SMART’s Return of Merchandise Authorization (RMA) group, Option 5, 
+1.866.518.6791, for shipping damage, missing part and repair status issues.

Online www.smarttech.com/contactsupport 

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com 
 

http://www.smarttech.com/support
http://www.smarttech.com/trainingcenter
http://www2.smarttech.com/st/en-US/Where+to+Buy/
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
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General Inquiries

Registration
To help us serve you, register online at www.smarttech.com/registration.

Address SMART Technologies
3636 Research Road NW
Calgary, AB  T2L 1Y1
CANADA

Switchboard +1.403.245.0333 or
Toll Free 1.888.42.SMART (U.S./Canada)

Fax +1.403.228.2500

E-mail info@smarttech.com 
 

mailto:info@smarttech.com
http://www.smarttech.com/registration




Toll Free 1.866.518.6791 (U.S./Canada)
or +1.403.228.5940
www.smarttech.com
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